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Virus Infection?

 Don’t Buy a New Computer Because of It
by Leo Notenboom

I
f you’ve never been infected with a computer virus, it is likely you know someone

who has. They are real, nasty threats that can destroy information on your

computer. You might “catch” them by downloading illegal files, opening a bad

attachment, or surprisingly enough, clicking on bogus browser pop ups that warn

you’ve been infected. It can be a frustrating and time consuming process to get the

viruses removed.

However, you should never have to buy a new computer because of virus

infections.

This “solution” occurs often enough that it’s important to clear up the confusion

by examining the difference between hardware and software.

Hardware are physical things you can touch, see, and feel. This includes your

computer, monitor, or hard drive, for example.

On the other hand, software is simply data: a large collection of ones and zeroes

stored on magnetic, electronic or optical media. Software can include Windows, your

applications, and anything else stored on your computer...including viruses.

Viruses wreck havoc and cause your computer to misbehave; however, they are

really nothing more than data. And, data can be replaced without replacing your

computer.

Look at it this way. You probably wouldn’t replace your toaster if your bread was

moldy. You’d likely throw away the bread, clean the toaster and start with new fresh

bread. In the same way, you can get rid of the “bad software,” clean your software and

start over. This solution works even after the worst malware infection.

Instead of throwing away the parts, here are a few better options for handling

an infected machine.

Prevention: The smartest solution is of course to never become infected in the

first place. Effective prevention methods may include installing, and updating,

anti-virus software, securing online mobile connections, and not falling for e-mail

phishing scams. Also, avoid downloading software from places known for malware,

such as illegal file sharing sites.

Attempt to Clean it: If your computer does get infected, the next step is to clean

it by scanning with your anti-virus program, and other tools until they tell you that

everything is gone. You may have to scan several times before this happens.

Unfortunately, cleaning cannot guarantee your computer is virus free.

Start Over: Erasing everything and starting over is the only way to be 100%

certain you’ve removed all traces of the infection. This requires backing up everything,

erasing the hard disk, and then reinstalling Windows and all your applications from

scratch and selectively restoring your data files from your back up. This process takes

the most work, which is why it is preferable to focus on prevention and avoid this step

in the first place. But, it is the best solution.
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Remember, computer viruses are an active threat and if you take precautions,

you never need to worry about getting or removing them. However, if you do become

infected, buying a new machine is never a step you need to take.
Get more free tech help and advice from Leo Notenboom by visiting http://ask-leo.com With over

30 years of industry experience, including an 18 year career as a software engineer with Microsoft, Leo
gives real answers to real questions from ordinary computer users at Ask Leo! Subscribe to Leo’s weekly
newsletter now and receive a free ebook: “Internet Safety – Keeping Your Computer Safe on the

Internet,” a collection of steps, tools and concepts you need to know to keep your computer and your
information safe. Article Source: http://EzineArticles.com/?expert=Leo _Notenboom

Microsoft Rolls Out “SkyDrive”

 Online Office Apps and Storage
by Ira Wilsker

I
t is obvious that there is some heavy competition between Microsoft and Google in

the online document market. About a year ago I wrote about the services offered

by Google Docs (docs.google.com), which includes free online document creation and

editing, along with online storage and collaboration. Microsoft has also been providing

a somewhat similar service, originally with its Office Live Workspace (beta), but now

with its enhanced and upgraded SkyDrive service, which is also free (explore.live

.com/windows-live-skydrive). While the office components in Google Docs are generally

compatible with Microsoft Office, Microsoft’s SkyDrive provides a free online version

of Office. Since SkyDrive is online, it is accessible from anywhere there is an internet

connection, and works with most browsers; I tried it on Firefox and Internet Explorer,

and it worked flawlessly on both browsers. SkyDrive is platform independent, and

works equally well on a PC and a MAC, or any other op-erating system with a

compatible browser and internet access. Documents can be “collaborated” and edited

or shared with others, even if the other users do not have Microsoft Office. Microsoft

SkyDrive offers 25MB of free storage, an adequate if not generous amount of storage

space for almost all users. SkyDrive requires registration, which is free; registered

users of most other online Microsoft products, such as the other Microsoft Live services,

Hotmail or Messenger can use their existing usernames and passwords on the

SkyDrive service.

One of the primary features is the “Office Web Apps for SkyDrive,” which

includes online versions of Word, Excel, PowerPoint, and OneNote. Clicking on the

“Office” link will open up the basic Office App page, where the desired application can

be opened. The first window for all of the apps is very simple, where the user is asked

to enter the name of the document. I started typing this column on the online Office

Word App, and the screen was almost identical to the desktop version of Word. Anyone

who can use Word, or another similar word processor, will find the online Word app

familiar and easy to use; almost all of the features, commands, controls, and features

of the desktop version are available in the free online version of Word. In terms of

functionality, I could not find any significant differences between the web and desktop

versions of Word. The user can choose to save the file on the SkyDrive servers (the
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default), print, and share the document. Under the “Share” option, others can be

invited to view or edit the document, all under the control of the original user.

As with Word, the online Excel App has the same look and feel as the desktop

version of Excel. To open a new workbook, the clean opening screen asks the user for

a file name, and then the workbook opens. Once data is entered, there is no “Save”

button, as the Excel App continuously saves the workbook as it is produced. The user

also has the option to “Save As” and save the workbook under another name. Unless

explicitly downloaded to the computer, all of the workbooks are saved to the SkyDrive

servers. Workbooks can be selectively shared with others, while the others can be

granted access only to view the workbook, or edit it; this is the heart of online

document collaboration. 

I frequently do PowerPoint presentations, and the SkyDrive PowerPoint app

offers the ability to create, edit, store, and show a PowerPoint presentation from

anywhere there is internet access. When opened, the PowerPoint app has the same

look and feel of the desktop version, and uses the same command set. As with Excel,

there is no “Save” button, as the presentations are automatically saved as they are

created. One interesting feature is that when a PowerPoint presentation is shown

(“View – Slide Show”) it opens in a browser pop-up window, so the user must allow

browser pop-ups from the application in order for the slide show to be viewed. If

connected to a projector, the output looks the same as if it was from a desktop version

of PowerPoint. As with all of the other Office online apps, the user can choose to share

the file with others, and selectively allow others to edit the file. Since Microsoft

provides 25MB of free storage, SkyDrive is a practical place to store presentations; if

for some reason the presentation must be shown from a computer lacking Office, the

SkyDrive file can be shown, as long as there is internet access.

Microsoft OneNote is hard to explain, but basically both the desktop and

SkyDrive App versions are both note-taking utilities. OneNote can easily organize any

notes that are taken, and would be useful in a classroom, organizational, or

professional environment where notes are taken. OneNote looks like a simplified

version of Word, but allows the user to “flag” important points, or quickly search for

desired terms or phrases. OneNote can incorporate images, web pages, and video, and

can itself be incorporated into Word or PowerPoint. A few of my stu-dents use OneNote

to share class notes during my lectures, ensuring that each of them has a

comprehensive set of notes for test reviews. As with the other Office apps, it can be

selectively shared with and edited by others. As with some of the other apps, there is

no “Save” button as the information is saved to SkyDrive in real-time. 

I have several students who do not have Microsoft Office on their personal

computers, but need to be able to access Word, Excel, PowerPoint, and OneNote;

SkyDrive is a free alternative to Microsoft Office, provided that the student has

internet access. For the frequent times when several of us must work together (there

is that “collaboration” term again) on an Office file, SkyDrive could be the appropriate

utility that we could all share, giving us secure and controlled access to our files. For

those who have the desktop version of Office 2010, there is a direct and transparent

online connection with SkyDrive, allowing files to be saved on SkyDrive directly from
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the desktop Office. The SkyDrive files can be selectively shared with anyone on

Facebook, MySpace, LinkedIn, AOL Mail, Hyves, Gmail, Outlook, other Windows Live

users, and anyone else with an email address. For security and privacy reasons, access

is limited to only those authorized by the user, and that degree of access is also under

the control of the original user.

I found SkyDrive and its Office Apps to be every bit as useful as their desktop

counterparts, with the bonus of secure online storage of files. Some of us have used

SkyDrive and its apps to work together on producing Word documents and PowerPoint

presentations, without the need to physically swap files between us. SkyDrive and its

Office Apps would be very worthwhile for any computer user with internet access.

WEBSITES:

http://explore.live.com/windows-live-skydrive

http://docs.google.com

Nothing is Forever
by Harry McCracken

I
can tell you when I bought my first computer. (1982–it was an Atari 400 with a

tape drive, which I bought at a Service Merchandise in New Hampshire.) I can tell

you when I got my first VCR (1985–a cheesy Sharp model with a wired remote; I

think I bought it at the late, lamented Boston electronics retailer Lechmere). Same

thing for cell phones (a Nokia I still miss), MP3 players, and all sorts of other gadgets.

Countless technology products have meant a lot to me. Few have meant a lot for

more than a few years, though–they tend to either break or be rendered obsolete by

something even more exciting. And even entire classes of products which I thought I

couldn’t live without eventually become dispensable.

Herewith, a few categories of gear I’ve owned, and my best guess as to whether

I’m done with them yet.

Laptops. I suppose the day may come when I use some seventh-generation iPad or

Android tablet as my only general-purpose computing device. In the short term,

though, I expect to continue on buying MacBooks and Windows notebooks as my

primary machines.

Desktop PCs. I bought my last one right before Windows Vista came out. Unless I

unexpectedly take a job that requires me to sit in one place all day long, I don’t expect

to buy a desktop computer ever again–it would be sort of like buying a bicycle without

any wheels.

Computer monitors. I have a perfectly pleasant 23" Samsung widescreen display, but

it sits unused; I’ve just gotten used to computing anywhere and everywhere rather

than at a desk. (I do assume that I’ll eventually buy multipurpose “displays” that are

both TV sets and computer monitors in one handy-dandy device.)

Mice. On the rare occasion when I’m seated at a desktop, I like using a trackball. But

it’s been years since I’ve bought one, and even longer since I’ve bought a mouse. These

days, when I close my eyes and think “pointing device,” what I see is a touchpad.
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Printers. I have an HP all-in-one (the first and only all-in-one I’ve ever owned). I’m in

no rush to replace it, but I assume I will at some point. Less clear: Will I still want to

print out stuff on dead trees in, say, twenty years?

Networking routers. I have a two-year-old Wireless-N one sitting next to my cable

modem. It’s likely to keep on being perfectly useful for several years to come, but I

expect that some technical development will eventually lead me to upgrade.

HDTVs. I’ve owned a flatscreen for three years, and while I hope to keep on watching

it for years to come–I look at it more like a car than a PC–I’m sure it’s not my last TV

set.

Cell phones. I expect to purchase many of them–too many, probably–over the next few

decades. I’m having trouble coming up with any scenario which would render them

obsolete.

MP3 players. I owned and loved a bunch of them over the years, from the original Rio

PMP300 to the Creative Nomad Jukebox to too many iPods to count. But with the

possible exception of devices I might purchase to review, I’m pretty confident I’ll never

buy another MP3 player that isn’t also a smartphone.

Digital cameras. It’s possible my new Canon PowerShot S95 is the last point-and-shoot

I’ll ever buy, but I don’t think it’s likely, unless some unexpected technological

breakthrough leads to spectacular smartphone cameras.

Video cameras. I bought a Flip a couple of years ago–after having owned various other

video cameras dating back to the days of 8mm tapes–but wouldn’t do it again. For me,

video capture is a feature built into phones and still cameras, not a product category.

DVD players. I last bought a standalone one a couple of years ago–a midget-sized unit

that fit into my bulging entertainment center. I only see myself buying another if this

one conks out and I still have DVDs I want to watch. But I bet I’ll acquire more devices

with DVD drives or burners built in–they’re kind of like floppy drives.

VCRs. I picked up one just recently! It’s a combo unit that lets me burn stuff from VHS

onto DVD. In other words, it’s designed to help me leave the world of tape behind. If

I find the time to dupe my tapes, this might be my last VCR, after a quarter-century

of owning them.

Audio cassette decks. Can’t tell you when I last bought one; don’t have one in the

house; can’t imagine why I’d buy another, except maybe to digitize a unique tape or

two. (I interviewed the Car Talk guys years ago, and the tape is around here

somewhere...)

LP turntables. I bought one of those ION USB turntables last year, but haven’t had

time to play with it much. I will, though: In fact, I still buy the occasional collectible

LP. But I’d only buy another turntable if this one croaked–and maybe not even then.

FM radios. I picked up a nice Boston Acoustics clock radio around three years ago–but

rarely use it these days. If it turns out it’s the last FM radio I ever buy–not counting

ones that come with automobiles wrapped around them–I wouldn’t be the least bit

surprised.
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Analog wristwatches. The one I wear every day is older than I am–and it still looks

good and keeps excellent time. But I’m sure I haven’t bought my last one; I’ll probably

still wear a good old fashioned watch long after I’ve lost interest in neatly every type

of gizmo that’s a big deal at the moment.

What major technology products do you think have reached the end of the

line–at least for you? Drop me a line at harry@technologizer.com and let me know. And

see you at Technologizer.
From the December 3rd, 2010 issue of Technologizer’s T-Week. Used with permission. Check

it out at Technologizer.com.

Stream Media over the Internet
by Kim Komando

Y
ou probably have videos, pictures and music on your home computer. That’s nice.

But you probably want to access this content from other places. For

example, you may want to watch home movies on your laptop when you’re

traveling. Or maybe you want to view your photos from your cell phone.

In that case, Orb may be the solution you need. This program streams your

media over the Internet. And it uses a secure connection.

Using a laptop, you’ll get full access to your media. You can also access your

media from your cell phone. It must have a media player if you want to watch videos.

Orb can do more. You can stream live television via Orb. That means you can

watch your programming wherever you go. You can also use it to record television

programs-remotely!

Orb will also let you view your media files on your television. All you need is a

Wii, an Xbox 360, or a PlayStation3.

Orb will even let you monitor your home from afar. Just connect a compatible

Webcam to your computer. Orb will send you a text or e-mail alert if motion is

detected. Or, log on to see what’s going on at home.

Cost: Free

Systems: Windows XP, Windows Vista, Windows 7, and Mac OSX 
Locally you can hear Kim’s program on WHAM 1180. To subscribe to Kim’s newsletters go to:

http://www.komando.com/newsletters/

What is a Document Management System?
by Bob Rankin

D
ocument Management Systems A document management system (DMS) is a

combination of software and hardware used to track, store, and retrieve elec-

tronic documents and digital images of paper documents. A typical DMS has

several components and functions. Document capture is the process of scanning a

physical document into a digital form. Metadata is usually added to a captured

document to describe its content and define key words that wll be used to find it again.

Integration of documents with other applications allows a word processor, for example,
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to locate a document in the DMS, import it into the current document, and save the

new version under a different name.

OCR (optical character recognition) is the process of scanning a physical docu-

ment’s handwritten or typewritten

text and converting its characters into

digital text. OCR enables conversion

of many mounds of paper into compact

text files on a hard drive, without the

tedious task of re-typing it all. In

digital form, the text can also be

indexed and searched, reformatted

with word processing or other types of

software, and shared among many

users simultaneously. OCR software

such as PaperPort and OmniPage

(both from Nuance Communications)

are highly accurate and fast at

scanning standard fonts in English.

Handwritten text still presents challenges for OCR technology.

Some desktop scanners can scan documents for digital storage, and use OCR to

convert them to searchable PDF documents. The Fujitsu ScanSnap is a popular

example, used in many homes and offices. Scanners with OCR capability are especially

useful for lawyers, accountants, and other professional services that tend to deal in

large amounts of paperwork.

Digital signatures may be required in a regulated industry such as law, real

estate, or medicine to verify the identities of every person who handled or altered a

digital document. A digital signature may include a graphic image of the signatory’s

actual signature, or it may be an encrypted certificate that can be inserted into a

document only by the owner who knows its password. See my related article on Digital

Signatures to learn more about how they work.

Content Management Systems

Web content management is vital to most enterprises these days. The thing

about Web content is that it’s fluid; a Web page can change at the whim of a

programmer or depending on the identity, input, and preferences of a user. Earlier

versions may be lost unless they are archived. Web content management systems

include blog software such as Wordpress and Joomla. It can also be more sophisticated

software that integrates OCR, paper document storage systems, retrieval and

distribution services. You can read my article Content Management Systems for

examples of solutions for both non-technical and more tech savvy users.

Document management companies include Xerox, Belwo, Infushui, and other

makers of document scanning, printing, and OCR equipment. Many smaller firms

specialize in the integration of hardware and software from various companies and the

customization of a DMS to a company’s specific needs.
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Then there are firms which specialize in storing and destroying physical

documents. Tax records, medical records, legal paperwork, government records of all

kinds must be preserved safely for years, or indefinitely. Document storage services

provide climate-controlled, disaster-proof storage facilities for such documents and the

ability to locate and retrieve a particular piece of paper quickly. At the end of the

required storage period, these firms fulfill legal requirements for the confidential and

complete shredding and disposal of documents.
From The Internet Tourbus, TOURBUS Vol 15, Number 57, 29 Nov 2010. To subscribe go to

http://internettourbus.com/tickets.html 

ORGANIZE, ORGANIZE, ORGANIZE!
by Ron Hirsch

Boca Raton Computer Society , FL

T
his article is aimed at those readers who always promise themselves that they

are going to get organized, especially in the area of their computers. I know that

most people have CD’s, notes, and manuals scattered all over the place. Do you

qualify? If so, this article may be of interest to you. It is not just aimed at your com-

puter activities, but at any activity that accumulates lots of pieces of notes, and printed

material, and other items. 

I tend to be an “over organizer.” And often I’m criticized for being too neat and

organized. Doing a good job of organizing can take a fair amount of time. But the time

saved when trying to find something may well be a bigger number than the time it took

to organize things in the first place. 

On Taking Notes in General

We all have occasion to take notes, make notes to ourselves, and often scribble

down things while we’re on the phone. I personally am online, or on the phone, often

to a hardware or software company, trying to fathom the idiosyncracies of some bug,

or problem. And, I’m usually taking some notes on things, or printing out pieces of

pages. And these days, I visit many places on the Internet, where there are text files

etc., which can be downloaded with lots of good information. 

The average desk is strewn with bits of paper, corners of magazines, and just

about anything that accepts pen of pencil scribbling. Often the pieces get lost, and more

often they get thrown out. And, a good part of the time, we can’t read what we wrote,

because there wasn’t enough room on the scrap used, and the “shorthand” is now

unreadable. And more often than not, such material gets “filed” in a shoe box or the

like, and totally disorganized. 

Well, I solved the problem many years ago. I bought a package of spiral

notebooks. Anytime I have to take notes, I grab the appropriate notebook, and put

everything down in it. I have plenty of room on the page(s), so I don’t have to cram

things in. I date the top of the page, and since it is all bound together, I can’t easily lose

it. This makes for an excellent record, with the ability to go back in time to retrieve old

notes. Furthermore, it also allows you to “forget” important details, since you can now

refresh your memory, needing only the approximate time period involved. Having it
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in a spiral notebook is important. The pages stay in chronological order, they won’t get

lost as with a looseleaf notebook, and the spiral binding is easy to keep open at the

desired page. 

By now, you might be saying – “big deal – we need someone to tell us how to

keep notes.” Well, I have my notebooks going back for 12 years or so, and they come in

very handy. I now keep several, one for each desktop computer stuff, and a separate

one for household stuff, and actually any major situation or project. When we were

putting on the addition to our home in Boca, I had a special one just for that also. It

was so helpful, and had so much info recorded, that I guarded that notebook with my

life. 

And Now an Additional Approach – a Looseleaf Notebook 

I know that just said above that a spiral notebook is best, and that is so for

keeping notes et al. But, there are times when we all have documents and papers

applicable to a given subject, and these, are already printed out so what should we do

with them? In the distant past, I had a whole library of looseleaf notebook with the in-

dex separators, and I used to laboriously print out small labels to slip into the tabs,

with the subject neatly printed out there. This was back in my early computer days,

when I assumed that when one had a given program, one used that for life. Of course

that was very naive. 

After adding more and more software, and obsoleting older software regularly,

I got tired of having to change all the labels in the tabs, and came up with a better

solution. I used A to Z letters in the tabs. And, I made up a bunch of such looseleaf

notebooks, and numbered them from 1 to 10. On the first notebook, I generated an

index page, and slipped it into the clear window on the front cover of the notebook. This

page lists the description of the stored documents, and their location, such as 2B or 5H

– for all the notebooks. When that page became full, I added more pages, and just kept

them in loose leaf #1, inside the front cover. I generated the index page in WordPerfect,

but Word or any text editor is fine. I sorted the list alphabetically, and printed it out.

When I have occasion to add in new items, I pencil them and their location onto

the index page using the blank area at the end of the index. And, I remove old obsolete

items by drawing a line through them. Then periodically, I edit the index page in the

computer, resort it, and print out a new copy. When a particular subject has a fair

number of pages, it gets its own location, such as 7F. But there are many items that

are a single page, so I let them share a common location. After all, when referring to

one of 5 single page items in a single location, it is quite easy to find the proper page

out of the 5 that are there. 

CD and Disc Management 

I ended up using a similar approach here. In years past, I used the 3½” and 5¼”

disc storage box, and printed specific labels for each program’s tab. This used lots of

dividers so that each program could have its own home. Back then, most programs

used floppies, and several floppies were the order of the day. These days, nothing comes

on floppies anymore – it’s all CD’s and DVD’s. So, I got to reuse all the desktop storage

cases I had for my 5¼” floppy discs remember them, they really were “floppy,” but they
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are perfect for CD’s and DVD’s. But, I still have a case with some ancient 3½” floppies,

as there are some 3½” floppies from the distant past that I want to keep. 

I now label the case dividers alphabetically. This is a one-time labeling job. I

store the program and other CD’s in one of the sections. I have about 8 such storage

units. I generated an index like I did for the loose leaf files above. Each storage box is

numbered from 1-8, and typically has about 5-6 sections in it. Of course, each section

can handle a number of CD’s, and many more when they are not in a jewel case. Most

companies don’t supply their CD’s in hard cases, but use the small envelopes with the

see through window on the front. 

So, the index ID’s go from 1A to 8E. And, I publish this index, which is 4-5

pages, and bind it using a GBC plastic comb. As discs are added or removed, I make

pencil notes at the end of the printed list. I periodically update the list on my computer,

and print out a new copy. 

One Other CD Approach

Various of the CD’s that I have are used regularly, as they have data or

whatever on them, and may be needed when a program is run. For this, and especially

when the CD is in a jewel case, I have a number of CD cases, which are widely sold,

and have 12-15 slots in them for jewel cases. They will also hold the thin cases, where

2 fit into the same slot. The regular jewel cases generally are labeled on the “spine,”

and can be identified when in the CD rack. 

NOTE: These days, with the very large hard drives that are around, many programs

which would normally require the data CD to be present when the program is run,

offer another option. During the install, if you elect a “custom” install, you’ can tell the

program to install all the CD data on the hard drive. This makes the program run

much faster, and removes the need for the CD(s) each time the program is run. I have

done this with DeLormes Street Atlas, .and Hal1marks Card Studio Deluxe. The Card

Studio used about 1.5 GB hard drive space to store the data, but with the many

hundreds of GBs I have available, this was no problem. 

Here’s a Very Important One

These days, many of the programs we use are downloaded, and then installed.

There’s no CD/DVD or floppy disc as of years ago. After the program is installed, most

people lose track of the install file, or delete it completely. And there are often

downloaded instructions, manuals, et al, which also tend to get lost in the mist as time

goes on. And, when the program is a paid download, there is often a

registration/activation key that is given to the purchaser, which is needed to keep the

program functioning. 

I have a good system to store all this information and keep it available for future

use. I set up a folder, on a drive other than my C drive, which I call “Program

Archives.” And in that main folder, I create a separate folder, which has the name of

the program which will be stored there. And as new versions may arrive, or patches be

issued, I keep them all in the appropriate folder. And furthermore, I keep copies of that

main “Programs Folder” folder in several other places, just for emergencies. 
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With all the material saved, whenever I need to reinstall that software, recover

from a hard drive crash, or just want to review the PDF manual, I have it all at my

fingertips. Believe it or not, the size of that main folder on my E drive is about 5 GB!

Having this material quickly available to me has saved my butt on numerous

occasions. 

One unusual case involved a program I love, and use often from a company that

was no longer around. So if I didn’t have the install file, and the registration key on

file, that would be the end of that program. 

Here’s another related tip. There have been several occasions when the CD/DVD

for an important program, such as Photoshop just won’t function properly during the

install. For some strange reason, Photoshop has acted this way with me for a number

of years. Neither Adobe nor I could fathom why. On two occasions, they sent me a

complete new set of discs, but to no avail. The solution which resolved the problem was

to copy the complete CD/DVD to a named folder on one of my hard drives, and then run

the install from there. Copying the disc like that also serves another purpose. If you

lose the disc, you still have the necessary files to reinstall things. 

In Closing 

I hope that some of you will get some good ideas about storage and note keeping

from this article. It’s never too late to get started, even if things are in a shambles to

start off. Do your housekeeping a little at a time, and you may find that being

organized isn’t such a big job after all. 
If you find this material useful, you may want to download this article in PDF format, from our

web site http://www.brcs.org/hirsch.php. This allows readers to keep the material either as a PDF file,

and/or print it out, and place it in a loose leaf notebook for future reference. Remember, the PDF version

offers full color, wherever color elements might be involved, and often images which could not be used

in the newsletter. From the October 2011 issue of  TUGNET, The Users Group Network, Granada Hills,

CA.

Excel Tips
(Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission.

Thousands of free Microsoft Excel tips can be found online at http://excel.tips.net) 

E
xcel includes a feature that allows you to outline your data. This simply means

that Excel analyzes your data and assigns different rows to different "levels."

These levels can then be selectively hidden or displayed, depending on your

needs. An outline is handy for getting a quick understanding of large amounts of data.

You can create an outline in several ways: 

• Insert automatic subtotals. Select a cell in a data list, then choose Subtotals

from the Data menu. (Display the Data tab of the ribbon in Excel 2007, then

click on Subtotal in the Outline group.) 

• Let Excel automatically outline your data list. Select the list that you want

outlined, then choose Group and Outline from the Data menu, then Auto

Outline from the resulting submenu. (If you are using Excel 2007, display the

Data tab of the ribbon, click Group from the Outline group, then click Auto

Outline.)
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• Manually outline your data list. Select the data you consider to be detail

information, then choose Group and Outline from the Data menu, then Group

from the resulting submenu. (In Excel 2007, display the Data tab of the ribbon,

click Group from the Outline group, then click Group.) Repeat the process for all

other detail information in the data list. 

Once your data is outlined, outline symbols appear at the left side of the worksheet.

You can display different levels of data by using the mouse to click on the various

symbols. 

Deleting a Header

When you create a new Excel spreadsheet, it contains page headers. If you want to

get rid of the page header, follow these steps: 

1. Select Page Setup from the File menu. This displays the Page Setup dialog box.

2. Make sure the HeaderIFooter tab is selected. Using the Header drop-down list,

select the very top predefined header. This appears as (none). 

3. Click on OK to close the Page Setup dialog box.

Recognizing a Header Row When Sorting 

There are two ways you can sort information in Excel: using the Sort Ascending and

Sort Descending tools on the toolbar or by using the Sort dialog box. Using the toolbar

tools allows you to do the sort more quickly, but Excel makes a few assumptions in the

process.

First, Excel assumes that you want to sort only by the column of whatever cell you

have selected. If you want to perform secondary and tertiary sorts on more than one

column (or row), you need to use the Sort dialog box. 

The second assumption affects exactly what Excel sorts. If you have a single cell

selected, Excel extends the selection to select a range (much like pressing Ctrl+Shift+8)

bounded by one or more blank columns and rows. It then examines the first row in the

selected range to determine if it contains header information or not. 

This is where sorting with the toolbar tools can become tricky, your header

(assuming you have one) must meet some rather strict guidelines in order for Excel to

recognize it as a header. For instance, if there are any blank cells in the header row,

Excel may think it isn't a header. Likewise, if the header row is formatted the same as

the other rows in the data range, then it may not recognize it. 

Only after selecting the range and determining if there is a header row will Excel

do the actual sorting. How pleased you are with the results depends on whether Excel

got both the range selection and the header row determination right. For instance, if

Excel doesn't think you have a header row, and you do, then your header is sorted into

the body of the data; this is generally a bad thing. 

To make sure that your data range is recognized correctly, use the CtrI+Shift+8

shortcut to see what Excel selects; this is what will be sorted. If it doesn't match your

expectations, then you need to either modify the character of the data in your table, or

you need to sort by selecting the data range before using the Sort dialog box.

To make sure that your heading is recognized correctly, use the CtrI+Shift+8

shortcut to select the data range, then look at the first row. If your header has blank
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cells among those selected in the first row, or the first row is formatted just like the

second row, or you have more than one header row selected, then Excel assumes you

have no header row at all. To correct this, make changes in your header row to make

sure it is recognized properly by Excel. 

Comma-Delimited Differences for PC and Mac

Excel allows you to save worksheet data in a comma-delimited format, so you can

use it with other programs. Comma delimited files are often referred to as CSV

(comma-separated value) files, and are often used for exchanging data between

programs. 

When selecting how to export you data, you need to be sure that you pick the export

format that is appropriate for the system on which it will be used. There are actually

three CSV formats included with Excel: 

• CSV (Comma delimited) (* .csv) 

• CSV (Macintosh) (*.csv) 

• CSV (MS-DOS) (*.csv) 

You can choose any of these CSV options by using the Save As Type drop-down list

at the bottom of the Save As dialog box. There are subtle ditIerences between all three

formats, but for most people, the first and third formats are essentially the same-they

both work on the PC. The second format, for the Macintosh, is worth noting, however.

If your export file is destined for use on a Macintosh, you should choose the second

CSV option. This option results in a CSV file where each record (each line in the fIle)

is terminated with a carriage return, as expected by the Mac. In the PC world, lines

are terminated with a carriage return/line feed combination, which can muck things

up on the Macintosh. 

If you are creating the CSV export fIle on the Mac for later use on the PC, you will

want to make sure that you select a CSV format appropriate for the target system. The

Mac includes CSV options for both Windows and MS-DOS systems. You should be able

to choose either option and have the fIle work just fine. 

Entering Numbers in Excel

When you enter information into a cell in your worksheet, you may wonder exactly

how Excel translates what you enter. Excel first tries to convert information into

numbers. Numbers are just that-any of the digits (0 through 9), optionally with special

characters. The most common of these special characters are the period (taken to be

a decimal point), a comma between numbers, a minus sign or plus sign, and a percent

sign after the number. If you use the percent sign, Excel assumes you are entering a

percentage, and thereby divides the number by 100 for internal storage. 

Other special characters can be used, as well. For instance, if you preface your

number with a dollar sign, Excel assumes you are entering a currency amount. You can

also enter numbers surrounded by parentheses-such as (123}-which is another way of

indicating a negative number. The slash character (I) can be used to indicate either a

fraction or a date. Finally, you can use the letter E (upper- or lowercase) to indicate

that you are entering a number in scientific notation. All of these different numbers

and symbols are summarized in the following table: 
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Symbol Meaning 

– If used before a number or after a number followed by the letter E (as in

I 23E-45), it is taken as a negative sign. If entered between numbers,

assumed first to be a date separator, unless the numbers are illegal for

a date; in which case it is considered text. If entered after a number, then

the entry is assumed to be text. 

++++ If used before a number or after a number followed by the letter E (as in

l23E+45), it is ignored. If entered between or after numbers, it is

considered text. 

()()()() When completely surrounding a number, assumed to be a negative sign.

In all other instances (except in formulas), assumed to be text. 

,,,, When followed by at least three digits, assumed to be a hundreds

separator. ,In all other instances, assumed to be text. 

//// If entered between numbers, assumed first to be a date separator-

provided the numbers can be translated to a valid date. In all other

instances, assumed to be text. 

$$$$ When preceding digits, assumed to indicate that the number represents

currency. In all other instances, assumed to be text. 

%%%% When following digits, assumed to indicate that the number represents

a percentage. In all other instances, assumed to be text. 

When used once within an entry, assumed to be a decimal point. In all

other instances, assumed to be text. 

  E  E  E  E or e e e e When used once within an entry, assumed to indicate that the number is

being entered in scientific notation. The value to the left of the E is

normalized to between I and 10, and the value to the right is used to

represent the power to which the value is raised. 

Remember that when you use symbols in your numbers, they must make sense. For

instance, you cannot input two decimal points or two percent signs and expect Excel

to understand what you are doing. If you try entering such a nonsensical number,

chances are Excel will assume you are entering text.

Setting Your Default Directory  

Normally, Excel starts looking for spreadsheets in the directory in which you

started the program. Typically this is your directory. If you want to change the default

directory path, you can do so in the following manner: 

1. Choose Options from the Tools menu. You will see the Options Dialog box.

2. Make sure the General tab is selected.

3. Change the Default File Location box to reflect the path of the directory you

want to use as the default for your Excel files.

4. Click on OK.
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More Free Online TV

 but Be Careful with This One!
by Ira Wilsker

I
n recent months, I have written several columns about some of the free utilities

that can be used to play live TV and radio on the computer. All of the previous

software products that I wrote about worked, and very few users reported any

significant problems with them. One regular reader of this column has been emailing

me telling me about a “fantastic” (his description) free TV utility that did not just

simply offer many of the same thousands of live TV and radio stations that the others

offered, but this one also offered some premium satellite and cable channels for free.

We exchanged several emails as I researched the software he praised, and I started to

be a little disturbed about what I found out about it. Now the author just released a

new version on November 12, so I decided to try it and report back to my reader about

what I found. This column is that report.

The software that this reader has been begging me to try is ChrisTV Online! Free

version 5.10, available for download from online.chris-tv.com/download.html. There is

also a “Premium” version that sells for $30 that has additional features. Both versions

claim “ ... access to more than 1800 TV channels and 600 radio stations from all over

the globe (more than 100 countries).” Written in Romania by Cristian Ciplea, this

software has a large following, but during the installation of the 5 MB download, I

started to get suspicious about the program.

After downloading the free version of the program and agreeing to the terms of

service, I was greeted by a window asking for my permission to install “Relevant

Knowledge” on my computer. Cognizant that most users simply click “Agree” and move

on, I decided to read the fine print before clicking on “Agree” and found that

RelevantKnowledge was a program that some security websites referred to as spyware

or malware, because according to one source (www.bleepingcomputer.com/uninstall

/1054/RelevantKnowledge.html), “Relevant Knowledge is a MarketScore variant that

monitors browsing habits and sends un-solicited advertisements. Relevant Knowledge

is bundled in many free-ware utilities.” On its own website, relevantknowledge.com is

self described as, “ ...part of an online market research community with over 2 million

members worldwide. 

RelevantKnowledge relies on its members to gain valuable insight into Internet

trends and behavior. In exchange for participating in periodic surveys on topics of

interest to the Internet community, and for having their Internet browsing and

purchasing activity monitored, RelevantKnowledge sponsors select software that its

members can enjoy for free.” Not wanting my surfing habits monitored, I refused to

agree to have RelevantKnowledge installed on my computer, and went to the next step

of the installation process. It is notable that older versions of ChrisTV Online! Free

may have included several other utilities considered by others to be spyware, but

besides the RelevantKnowledge mentioned above, this version 5.10 seemed to be clean

of malware.
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Next, I was given the option of having Chris TV install a browser toolbar on my

computer, and have my default search engine changed to the one affiliated with Chris

TV. I refused the toolbar and search engine, and went to the next step, which finished

installing ChrisTV Online! Free. Once installed, after rejecting its toolbar, search

engine, and RelevantKnowledge monitoring service, that program appeared to function

as advertised. In order to receive all 1800+ TV channels, the user must have Windows

Media Player, RealPlayer (or a RealPlayer alternative), Flash, and SOPfilter installed,

all of which are available as free downloads linked from online.chris-tv.com/download

.html.

Opening Chris TV Online!, I noticed that stations can be sorted and displayed by

genre’, including category (business, children’s, news, etc.), station type (TV stations,

radio stations webcams, video on demand), language, and alphabetically by station

name. Being ethnocentric, I decided to explore the 395 U.S. based TV channels listed.

The U.S. channels include network news (such as ABC news), local access channels

from all over the country, home based streaming TV from several geeks and nerds,

college TV stations (Brigham Young, Texas A&M, Cal Poly Pomona, George Mason,

and many others), CSPAN (1, 2, and 3), CBN (Christian Broadcasting Network), city

TV stations (San Diego, Rockville, Daytona Beach, Fairfax, among others), several

local FOX TV and dozens of independent TV stations, shopping networks, live webcams

from several cities (including Waikiki Beach), traffic cameras, religious stations, and

a wide assortment of other streaming TV. 

If these 395 U.S. channels are not enough, over 1400 other channels are available

from around the world. While all of the channels are not streaming 24/7, making them

unavailable at certain times, there is always a wide selection available. I especially

like the international live web cams which show real-time scenes from around the

world including traffic, street scenes, beaches, resorts, harbors, airports, government

buildings, and religious sites. Religious sites streaming live include the Kotel (Wailing

Wall) in Jerusalem, and the Vatican. One annoyance is that every few minutes a popup

which obscures part of the screen appears and advertises the Premium edition, touting

that it can also record any of the streaming media displayed; clicking on the red dot in

the upper-left corner of the popup will close the popup, only to have it reappear a few

minutes later.

The ChrisTV Online! Free 5.10 performed as advertised, and worked fairly well,

provided the proper media software was installed. For anyone considering this product,

who is also willing to put up with the irritating periodic popup advertising the

Premium version, and the attempt to install questionable software on the computer,

Chris TV Online! FREE would be a good choice. I emphatically recommend that users

do not install RelevantKnowledge or the toolbar, without which the product works fine,

except for the Premium version popup ads.

There is a companion free product, ChrisPC JTV Player, which allows the user to

“ Watch up to 500 Live Justin.tv channels.” These justin.tv channels (now offering 2019

channels) are mostly home produced channels displaying live video games, locally

produced music, webcams, barnyard scenes (really!), sky scenes, bird cages, aquariums,

and other varied independent content. While the free ChrisPC JTV Player works fine,
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I have one grave concern about some of the Justin.tv channels which it can display.

Several of the channels appear to be illegally pirated feeds of live commercial network

programming, a practice I strongly condemn. It appears that some video thieves are

capturing live satellite or cable feeds, and illegally rebroadcasting them over the

internet, a blatantly illegal and inappropriate action I will not condone. For this

explicit reason, I cannot recommend ChrisPC JTV Player and its Justin.tv connection,

and I strongly implore readers not to download this product.

While the Chris software itself seems to work fine, I do not trust any software

publisher that tries to get its users to install questionable third-party software

products, or enables the users to engage in potentially illegal activities, such as the

viewing of pirated copyrighted video products.

This is really not so different from the illegal music, video, and soft-ware websites

and services that provide pirated intellectual property, which has in some cases has

resulted in civil penalties against the users. For these reasons, I suggest that users

absolutely avoid the ChrisPC JTV Player, and be very suspicious about the ChrisTV

Online! Free version 5.10. There are several other competitive and free legitimate

products that do not pose such risks, and I suggest that users stick to those and not

these Chris products. Caveat Emptor!

WEBSITES:

http://online.chris-tv.com

http://online.chris-tv.com/comparison.html

http://www.chris-pc.com/jtv/index.html

http://www.relevantknowledge.com

http://www.justin.tv

Free Comprehensive

 Security Suite from Agnitum
by Ira Wilsker

O
nce again, another security software vendor has released a free PC security

program, joining an already crowded field of competitors, but his one is

different. While most of the free security offerings are single purpose programs,

such as antivirus only, anti spyware only, or firewall only, this one is one of the few

that offers an integrated and somewhat complete security suite for free. While many

in the U.S. may not have heard of this company, it is very popular in Europe, and has

an excellent reputation in the security field. This company, the pride of St. Petersburg,

Russia, is Agnitum, the publisher of Outpost Security Suite Free.

On my antiquated but still functional XP machine, which is now only used

occasionally since I started using my more powerful Windows 7 machine, I had used

the Outpost Firewall (free edition) from Agnitum, and was very satisfied with it. I have

been following Agnitum and its security products for over 10 years, and have always

found their products to be among the best. A few years ago, as I started to migrate to

integrated security suites from individual security programs, I started using other

products, but still held a warm spot for Agnitum, and its excellent Outpost Firewall

(free) that I had used for several years without any problems. I continued to
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recommend Outpost Firewall for those who needed a free firewall, and have never

regretted those recommendations. Recently I read online that Agnitum had released

a free version of its popular commercial (paid) security suite, Outpost Security Suite

Free. While Agnitum had released earlier versions of its commercial security suite,

they recently (December, 2010) released a free version with the moniker version 7.04,

recognizing that there had been earlier versions of the paid product. The new version

7.04 is available in both the new free version, and the paid commercial version.

While there are very few free security suites available (I am only aware of the

Outpost and Comodo free security suites), the Outpost Security Suite Free is the only

one that has earned the cherished VB100 certification for efficacy at protecting from

malware, something that its commercial brother has won more than ten consecutive

times. An 83.2 MB download for the free 32 bit version (updates.agnitum.com

/free/OutpostSecuritySuiteInstall.exe), and a 92.7 MB download for the free 64 bit

version (updates.agnitum .com/free/OutpostSecurity SuiteInstall64.exe), Outpost

Security Suite Free is a very comprehensive security suite. This fully functional free

suite includes antivirus, firewall (one of the best in the industry), antispam, anti

spyware, proactive operating software protection, free updates, and protection from

dangerous or hijacked websites. While this free version uses cloud com-puting for many

of its protections, it is very light on system resources and does not significantly degrade

computer performance. The free version, which is adequate for most users, has all of

the same functionality as the paid version, except the free version lacks the separate

identity theft protection feature (but identity theft protection is included in the firewall

of the free version), active technical support, multiple languages, and the number of

daily updates offered by the paid version. Despite lacking these “bells and whistles,”

the free version is totally adequate for most users. Outpost Security Suite Free will run

on 32bit and 64bit versions of Windows 7, Vista, and XP, and has low minimal

hardware requirements of a 450 MHz CPU, 256 MB RAM, and 200 MB of hard drive

space. With system requirements this “light,” the software will run fine on most

netbook computers and other older computers.

Outpost Security Suite Free has some interesting features, a few of which are

lacking in non-Agnitum expensive commercial competitors. Many of the current

malware threats in circulation can penetrate the installed security software by

deactivating or otherwise turning off the protection immediately prior to infecting the

computer; with Outpost, that is very unlikely. According to Agnitum, “There’s no way

Outpost solutions can be powered off by malicious applications. Whatever tricks these

may use, Outpost preserves each and every bit of its file structure and guarantees

ongoing protection.” Another very powerful feature of the Outpost Security Suite (both

Free and Pro versions), which dwarfs some of its competitors is its scanning speed,

where it is one of the fastest scanners available. Outpost Security Suite uses what it

calls its “SmartScan technology” which it claims “ ...dramatically reduces scanning

times by caching previous check results and handling new file modifications.” Much of

the malware circulating attacks the operating system in its attempt to take over the

computer; Outpost Security Suite uses a proprietary “System Guard” to protect the

operating system from being taken over or otherwise compromised by malware.
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Novices and expert users alike will appreciate the “cloud computing” aspects of

Outpost Security Suite, especially in its ability to automatically configure itself using

its cloud based ImproveNet user collaboration network. ImproveNet automatically

configures the software and implements rules that control how the most popular

applications access the web. While the expert user may want to customize the rules

and configurations, the novice user will find that the settings automatically

maintained by the ImproveNet user network will provide excellent protection without

the need to set rules or other forms of control. Simply, Outpost Security Suite just

works as installed, without tweaking and configuration. For those who may want to

use only parts of the suite, such as the excellent and highly rated firewall, the expert

user can selectively turn off the unwanted components, retaining only those desired

components. While the blogs contain some posts by expert users who swear by this

selective process, using only selected components along with products from other

software publishers, the typical user is well served and protected by using the entire

suite with its default setting, and the rules automatically implemented by the

ImproveNet user collaboration service.

For those who do not have an integrated and comprehensive security suite, Outpost

Security Suite Free would be an excellent choice to replace what you may already be

using (or not using). If your commercial security suite is up for renewal, and you want

to look at a free alternative, this would be a very good choice. If you purchase or receive

a new computer for the holidays, Outpost Security Suite Free would be a wise choice.

As I have said many times before in this column, there is no valid reason not to have

security software, and with Outpost Security Suite Free, you can have excellent and

comprehensive protection at no cost.

WEBSITES:

http://free.agnitum.com

http://free.agnitum.com/why-outpost-security-free.php

http://free.agnitum.com/download.php

http://updates.agnitum.com/free/OutpostSecuritySuiteInstall.exe - Direct Download 32

bit

http://updates.agnitum.com/free/OutpostSecuritySuiteInstall64.exe - Direct Download

64 bit

http://dottech.org/freeware-reviews/18593
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Program Removal Options
Q. What’s the best way to remove a program?

A. When you need to uninstall a program, the first place to look is Start > Programs

> Name of Program, to determine if the program has its own uninstaller. Some do,

some don’t, but if it does, it’s always best to use a program’s integrated removal utility.

If it doesn’t have its own uninstaller, then go to your Control Panel and select

Add/Remove programs as your next step. If you encounter a stubborn program that just

won’t budge, all is not lost. In that case, it’s time to bring in the big guns and use a

third-party uninstaller such as Revo Uninstaller (www.revouninstaller.com), which

will get the job done.

Q. I’m sorry my knowledge is so limited, but I am not sure what is meant by a

“program.” I tried looking it up and asking some friends, but I never seem to be able

to get a straightforward answer that I can understand. If anybody can help me, I know

you can, Mr. M.

A. I’m feeling the pressure, so I’ll do my best: A program, by definition, is a set of

instructions that are grouped together to accomplish a given task or tasks. The

instructions are written in code or a programming language that a computer can

understand. Windows, which is your computer’s operating system, is a very complex

program comprised of millions of lines of code. Think of your operating system as the

engine that powers your computer and provides instructions to perform various tasks,

as well as interacting with software (smaller programs) that you install. A program is

variously referred to as “software” or an “application,” or “app,” for short. Word,

WordPerfect, PowerPoint, Quicken, Internet Explorer, Thunderbird and Firefox are all

popular programs. 

Q. I am running Windows XP. Can I create a desktop shortcut to turn my computer off?

I look forward to your newsletter every Friday. It is extremely helpful and informative.

A. Thank you. Yes, the exhausting process of clicking Start > Turn Off Computer >

Turn Off can be circumvented with a shortcut. To do that, right-click your Desktop and

choose New > Shortcut. In the Location field type in shutdown -s. (It has to be entered

exactly as it appears here, with the same spacing: shutdown space hyphen letter

“s”.)Click Next and either leave the existing “Shutdown” name or type a new name

such as “Off” and click Finish. Any time you want to turn off your computer thereafter,

double-click your new Desktop shortcut. Presto, offo!

Q. I need to establish a second email address. I am concerned that I not lose my current

email address, nor end up with my email in the wrong email account. Blessings and

thanks.
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A. I would suggest taking a look at Gmail (www.gmail.com), which is free, Web-based

mail. You can create as many accounts as you wish and no matter how many Gmail

accounts you create, they are all separate and distinct. Let’s say you create your first

Gmail account as aardvark@gmail.com, and your password is crumpet. You then decide

to create a second Gmail account and you select aardvarkmania@gmail .com as your

email address and use cumquat as your password. When you want to check mail for

your first account, you’ll log in using aardvark with the password crumpet. When

you’re done with that, log out and then log back in using aardvarkmania and cumquat.

Periodically, I check email in all seven of my Gmail accounts, so I just log in, check, log

out; log back in to another account, check, log out, log back in to the third account, etc.

Each account is autonomous so no messages will be commingled with any messages in

any other Gmail account. 

Mr. Modem’s DME (Don’t Miss ‘Em) Sites of the Month

Phone Scoop

With its breaking news coverage and in-depth reviews, Phone Scoop is one of the

most comprehensive resources for cell phone shoppers, users, enthusiasts, and

professionals, focusing on the U.S. market. The site’s database includes specifications,

feature lists, photos, links, and user reviews. Visitors can also choose specific phones

in a variety of ways and view detailed side-by-side comparisons. 

www.phonescoop.com

YouTomb

There are millions of videos on YouTube, but thousands have also been removed.

If any video footage online is challenged by virtue of copyright infringement, YouTube

will remove it. YouTomb is a research project conducted by students at the

Massachusetts Institute of Technology that archives the top videos removed from

YouTube so we, the people, can make our own decision whether the removal was

appropriate or not. We can’t do anything about it, of course, but if you would like to see

what was removed from YouTube, click on over to YouTomb. 

http://youtomb.mit.edu
For plain-English answers to your questions by email, plus great computing tips, subscribe to Mr.

Modem’s award-winning WEEKLY newsletter. Subscribe using Promo Code 1146 and receive a free

month (four weekly issues!) with your six-month subscription. To view a sample issue or subscribe, visit

www.MrModem.com. 

Miscellany

Thinking about a new computer?

http://windowssecrets.com/2010/12/02/01-Your-next-PC-thinking-beyond-the-

desktop/#story1

http://www.techradar.com/news/internet/25-handy-google-search-tips-

and-tricks-904624?src=rss&attr=newsintern
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Gizmo’s freeware
The best freeware reviewed and rated

http://www.techsupportalert.com/

Edit PDF Files Online for Free. No Download Required 

T
here are plenty of free programs around for reading PDF files but if you want to

edit a PDF file, your choices are much more limited. At least they were until

now. This web free service allows you to change the PDF text, move pages

around and much more. Because PDF Escape (www.pdfescape.com) doesn't just let you

edit PDF files (change the text, move pages around, etc., etc), it's totally free to use and

it's an online app. Because it's an online app there's nothing to download or install.

Just fire up your web browser, upload the PDF file in question, perform the required

actions, then download the results. No, it's not perfect, but for simple PDF editing it

is ideal and you certainly can't beat the price.

What to do
... when you see one of those "Your PC is infected!" warnings pop up on your screen.

Close the dialog without clicking any of its links. Go directly to a security site that you

know and trust, and run their on-demand scanner. Sites with good, free, on-demand

scanners include McAfee (Security Scan Plus http://home.mcafee.com/store /Product

.aspx ?productid=mss), Trend Micro (HouseCall http://housecall.trendmicro.com/),

Symantec (Security Scan http://security.symantec.com/sscv6/home.asp?languid=ie&

venid=sym&plaid=23&pkj=MFBSKVYRM HCGVRVRMNR), and ESET (Online

Scanner http://www.eset.com/online- scanner).

When you want to permanently install a security tool, do so directly from the

vendor's own site — not through unknown, intermediate pages or links. –Fred Langa

Society News
December 14, 2010 – Year End Meeting

Penfield Library

by Jan Rothfuss

D
ue to the weather, attendance was down but there were plenty of cookies.

There was no Help’s Half Hour. The only business discussed was a strategy

for confirming/cancelling scheduled meetings due to weather. It was

proposed that, when weather may be an issue on meeting nights, a decision will be

made by noon on the meeting day. An announcement will be placed on the web page

and an email will be sent to all on the RCSi e-mailing list.

This is fun:

http://storyofstuff.org/electronics/
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Those present then walked through various computer-based Jeopardy games

and had a great time (we didn’t keep score so we all felt very smart). Arpad did a

great job of entertaining us! 

The Lighter Side
People who plug their computer keyboards into hi-fi systems aren't idiots. To call them

that would be stereotyping. 

He dropped a computer on his toes. It caused megahertz. 

I got so angry when my cell phone battery died that my counselor suggested I find an

outlet. 


